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Introduction 
This startup guide provides basic guidelines for the minimum ISA100 wireless system with 
YFGW710 Field Wireless Integrated Gateway. It does not provide physical Installation, online 
device configuration, maintenance, service, or troubleshooting procedure. Refer to the Instruction 
Manual (IM 01W01F01) for more information and instructions. The manual is available on www.
yokogawa.com.

The target system of this document consists of Field Wireless Integrated Gateway 
YFGW710(GW: R2.5.7v2, BBR:p4.02.24) with Temperature Transmitter YTA510(R2.01.01) and 
ISA100 wireless network using Yokogawa configuration tools, Field Wireless Configurator (FWC 
R1.02.00), Field Wireless Management Tool (FWMT R1.02.01) and FieldMate (R2.05).

 Notes
• This startup guide may be revised periodically to incorporate updated information.

• Please use a computer’s administrator account to install or update the software.

• Any copy or reproduction of the content of this document, in whole or in part, without permis-
sion is prohibited.

 Trademarks
• The Yokogawa product and brand names appearing in this document are trademarks or 

registered trademarks of Yokogawa Electric Corporation.

• The company trademarks and registered trademarks appearing in this document are not 
marked with TM or ®.

•  All other company and product names mentioned in this manual are trademarks or regis-
tered trademarks of their respective companies.

All Rights Reserved Copyright © 2013, Yokogawa Electric Corporation Apr. 24, 2013-00
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1. Overview
This document describes one example of Field Wireless System confi guration procedure, which 
consists of one Field Wireless Integrated Gateway (YFGW710) and one Field Wireless Device 
(Temperature Transmitter YTA510). These are connected via the ISA100.11a Field Wireless Net-
work. The Gateway provides several communication interfaces such as Modbus /TCP for Host 
System and proprietary interface for system confi guration. The process data is acquired by the 
Host System via Field Network. The system confi guration parameters are modifi ed by Field Wire-
less Confi gurator (FWC) and Field Wireless Management Tools (FWMT) which are individual 
software and are used on Confi guration & Monitoring PC.

 System Architecture

Field Network

Field Wireless Integrated Gateway
(YFGW710)

Field Wireless Device
(YTA510:Temperature Transmitter)

[Configuration & Monitoring Software Tools]
• Field Wireless Configurator
• Field Wireless Management Tool
[Device Configuration Software Tool]
• FieldMate (Provisioning  Device  Tool)

[Configuration & Monitoring Software Tools

Configuration & 
Monitoring PC

Field Wireless Network
(Network ID=100)

Host System

Fig.1 System Architecture

Apr. 24, 2013-00
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 Work flow 
[Installation]

Step 1

 

Preparation (Chapter 2)

• Planning Configuration Items

• Installing Software and CF/DD File

• Connecting Cable

• Mounting Antenna

Step 2

 

Configuration (Chapter 3)

• PC Network Configuration

• Wireless System Configuration

• Device Provisioning

• Provisioning File Registration

• Download New Configuration

Step 3
Confirmation (Chapter 4)

• Wireless System Confirmation

• Backup Files Confirmation

[Operation & Maintenance]
   Monitoring Network Status (Chapter 5)

Apr. 24, 2013-00
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2. Preparation

2.1 Planning Configuration Items
2.1.1 Planning Device Provisioning Parameters

Before provisioning the Field Wireless Device, decide target Network ID and the Device Tag.

Table. 1   Device Provisioning

Item Settings Chap
Network ID 100

3.3Device Tag YTA510_1

2.1.2 Planning Network Information
Before configuring the Field Wireless System, decide the Network ID and Network information 
(Topology etc.) for the Field Wireless Network and the network between Gateway and Configura-
tion & Monitoring PC.
This setup example uses the settings shown in Table. 2 to configure the network in following 
chapter.
(See Appendix.2 [Blank Form] for additional information about each parameters.)

Table. 2   Network Information

Item Settings Chap
Network Information -

3.2.1

Network Information
Network ID 100
Description Not used in this configuration

IPv4 Settings -
IP Address 192.168.0.101
Subnet Mask 255.255.255.0
Default Gateway 192.168.0.1
NTP Server IP Address 192.168.0.1

Gateway -
Device Tag Use default setting [YFGW-GW001]

System Manager / Security Manager -
Device Tag Use default setting [YFGW-SM001]
Channels Use default setting [0-14]
Topology Star
Max Nodes Use default setting [50]
Max Latency (%) Use default setting [0]
Max Device Timeout (sec) Use default setting [120]
Advertise Period (sec) Use default setting [7]
Join Links Period (sec) Use default setting [4]
Packet Error Rate (%) Use default setting [15]

Backbone Router -
Device Tag Use default setting [YFGW-BBR001]
Filter Bit Mask (hex) Use default setting [FFFF]
Filter Target ID (Subnet ID) Use default setting [100]

Field Network (PC) IP Address 192.168.0.102
3.1

Subnet Mask 255.255.255.0

Apr. 24, 2013-00
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2.1.3 Planning Field Wireless Device Parameters
Before operating the Wireless System, sensor configuration parameters should be defined. This 
setup example uses the settings shown in Table. 3. (See Appendix.2 [Blank Form] for additional 
information about each parameter.)

Table. 3   Field Wireless Device setting

Item Settings Chap
Device information -

3.2.2

Device Tag YTA510_1
Device Role IO
Alarms configuration -
CF /DD CF File Name 00010202.cff

Sampling data -

Sampling  
Parameters

Update Policy Periodic
Publication 
Period (sec) 5

Stale Limit  
(Times) 50

2.1.4 Planning Modbus Register Mapping
When using Modbus communication between the Gateway and the control system in order to 
communicate process value and diagnostic information, this task needs to be performed. In this 
setup example, configure the Modbus register as shown below. (See Appendix.1 for additional 
information about Modbus function.) 

Table. 4   Modbus setting

Absolute Address Input Register  
Number Allocation Data Type 

 (words)

30001 0 Status Unsigned16  
(x 1)

30002~30003 1~2 DIAG_STATUS Unsigned32  
(x 2)

30004 3 Data Status Unsigned16  
(x 1)

30005~30006 4~5 PV Float  
(x 2)

Apr. 24, 2013-00
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2.2 Installing Software and CF/DD File
Table. 5 shows the software that is required for system configuration.
Install these software tools, Device Files, and the infrared adapter driver on Configuration & 
Monitoring PC.
For the installation procedure, refer to the instruction manual of the respective software.

Table. 5   PC and Software

No. Software Usage Required steps Instal-
lation

Opera-
tion

Mainte-
nance

1 Field Wireless  
Configurator

Wireless network  
Configuration

Install the software from 
YFGW710 accessory DVD ü - ü

2 Field Wireless 
Management Tool

Wireless network 
Monitoring

Install the software from 
YFGW710 accessory DVD ü (ü) ü

3
FieldMate Basic /
Advance  
and Device Files

Device Provisioning  
Sensor configura-
tion

Install the software from Field-
Mate DVD. 
(Need to purchase)

ü - ü

4 Infrared adapter 
driver Device Provisioning

Install the driver from Infrared 
adapter accessory DVD. 
(ACTiSYS Infrared 
Adapter[ACT-IR224UN 
9600bps])

ü - ü

5 CF/DD File

Field Wireless De-
vice Registration 
(CF files contain 
the vendor names, 
model names, revi-
sions etc.) 

(1)Confirm the appropriate 
revision on the website .[*1] 
<http://www.field-wireless.
com/en/download/index.html> 
->“Support for Field Wireless 
Devices and FieldMate /PRM”  
 
(2)Save the CF/DD files to the 
recommended folder below. 
<C:/Yokogawa/FieldWireless/
CFDD/59543/**** [*2]>. 

ü ü ü

[*1] The second bit positioned character on a Main name plate [SUFFIX column] of Field Wireless Device indicates
“Amplifier housing basic specification code”.

[*2] “0005” for Temperature Transmitter YTA510, 
“000c” for Pressure Transmitter EJX series
“1802” for Multi-Input Temperature Transmitter YTMX580.

Apr. 24, 2013-00
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 Recommended System Requirements
• Field Wireless Configurator, Field Wireless Management Tool
[Supported Operating System]

Windows 7 Professional Edition (32bit/64bit)
Windows Vista Business Edition Service Pack 2 or later (32bit)
Windows XP Professional Service Pack 3 or later (32bit)
Windows Server 2008 Enterprise Service Pack 2 or later (32bit/64bit)
Windows Server 2008 Enterprise R2 (64bit)
Language: Japanese or English

[Hardware Requirements]

Item Windows 7/2008R2 Windows Vista/2008 Windows XP 
Processor Intel Core2Duo 2.66GHz or more Intel Pentium4 2.8GHz or more 
Memory 2GB or more 1GB or more 
Hard Disk Drive Minimum free space of 

32GB or more 
40GB or more 
(15GB or more) 

20GB or more (minimum free 
space: 15GB or more) 

Display 1024 x 768 High color, 32bit 
Network port Ethernet Network port 

• FieldMate Basic/Advance
[Operating System]

Windows 7 Professional, Home Premium 32bit/64bit SP1 or later
Language: Japanese , English , Chinese (simplified), German, French, Russian
Windows Vista Business 32bit SP2 or later
Language: Japanese , English , Chinese (simplified)

[Hardware Requirements]

Item Windows 7 Windows Vista
Processor Intel ® Core™2 Duo T7100 or similar specification CPU
Memory 2GB or more 1GB or more

(2GB or more recommended)
Hard Disk Drive 8GB or more 
DVD-ROM Drive Windows 7 compatible Windows Vista compatible
Display 1024×768 or better resolution

recommended
Windows 7 compatible

1024×768 or better resolution
recommended
Windows Vista compatible

Apr. 24, 2013-00
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2.3 Connecting Cable
This chapter describes the connection of the power supply cable, grounding cable and network 
cable and also the mounting of the antenna.

2.3.1 Connecting Power Supply Cable
Pull the power supply cable into the gateway.
Connect the power supply cable to the power supply terminal in the gateway.

Connect the + and – wires to the + and – 
terminals, respectively.
If the power cable is a shielded cable, the 
shield should be grounded at terminal 
and the grounding of the whole cable 
should be restricted to this point only.

Power supply terminal

Cable gland for power supply cable

Power supply cable

1. Pull the power cable into the housing of Gateway.
2. Connect + lead wire to + terminal and – lead wire to – terminal.

Apr. 24, 2013-00
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2.3.2 Connecting Ground Cable
To connect the grounding cable to YFGW710 directly, use the grounding terminal on the right bot-
tom of the main body. Do not share the ground wiring with other devices. (Grounding resistance 
of 100 Ω or less is necessary.)

1. Internal grounding terminal
If the power cable is a shielded cable, the shield should be grounded at the terminal marked.

2. External grounding terminal

M4 screw

(Bottom of the enclosure)

Apr. 24, 2013-00
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2.3.3 Connecting Network Cable
Connect the metal network cable according to the following procedure. 

Cable Gland for Network Cable

Metal Network Cable

Ethernet Connector

1. Pull the metal network cable into YFGW710.
2. Connect the metal network cable to the network connector.

NOTE
Use the metal cable conforming to the standard of 100BASE-TX. 

Apr. 24, 2013-00
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2.4 Mounting Antenna
Screw the provided antenna into the connector on the top of the body. 

Antenna connector

1. Unscrew the antenna connector cap on the antenna connector.
2. Screw the provided antenna into the antenna connector.

Tighten the antenna connector with a torque of 2 to 3 N∙m.

Apr. 24, 2013-00
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3. Configuration

3.1 PC Network Configuration
Configure the network settings (IP address of PC) as shown in Table. 2.

NOTE
Before starting configuration tools, “Automatically detect Proxy” setting of internet browser needs 
to be disabled.

3.2 Wireless System Configuration
3.2.1 Network Configuration

1. Start [Field Wireless Configurator] from the Start menu of Configuration & Monitoring PC.

2.  Enter “admin” in Login Name and Password, and click [OK].
• Default Login user is “admin” and password is “!admin”.

3.  Select [New Project] from the File menu.

Apr. 24, 2013-00
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4.  Refer the Table. 2 (Chapter 2) and configure the gateway network settings such as Network 
information, IPv4 Settings, Gateway System Manager/Security Manager and Backbone 
Router.

[*1]

[*1]  The ISA100.11a field wireless network uses the wireless frequency bandwidths for the respective channels defined in the IEEE 
802.15.4. Clear the check boxes for the channels whose use is prohibited by the law of your country. 

5.  When the configuration of the parameters has been completed, select [Apply changes] and 
click [OK] to complete the configuration.

Apr. 24, 2013-00
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3.2.2 Field Wireless Device Configuration

 Register Field Wireless Device (Offline)
1.  Select [Devices] tab and click [+] icon to register Field Wireless Device.

2.  Enter [YTA510_1] in Device Tag.
•  Device Tag needs to match name entered in Provisioning Device Tool in the following 

procedure.

Apr. 24, 2013-00
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[Loading CF/DD File]

3.  Refer the Table. 3 (Chapter 2) and click [Load CF/DD] and select the CF file for Temperature 
Transmitter YTA510 from recommended folder.
<C: /Yokogawa/FieldWireless/FieldWirelessConfigurator/CFDD/59543/0005>

[Setting Device Role]

4.  Select [IO] in [Device Role] and uncheck the [Router].

Apr. 24, 2013-00
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[Setting Publication Period]

5.  Select [Sampling Data] tab.
Click [DIAG_STATUS] in Available Parameter window, and select [>] button.
Enter 5 (sec) in Publication Period and 50 (sec) in Stale limit.
When the configuration of the parameters is completed, select [Apply] and click [OK] to ap-
ply the configuration.

 

 
 

 Setting Modbus Resisters
Refer the Table. 4 (Chapter 2) and map the process data (parameters) to the gateway register.
1.  Click [Modbus Configuration] tab.

Drag and drop [DIAG_STATUS] to the Input Register Number 0-2.

 

Apr. 24, 2013-00



  3. Configuration 18

TI 01W01A55-01EN

2.  Drag and drop [PV] to the Input Register Number 3-5.

NOTE
To remove the Inputted Register, click the registered data from the [Input Registers] area and 
press delete key.

3.  When the data mapping has been completed, select [Apply Changes] to apply the configu-
ration.

 Save Project File
1.  Select [Save Project As] from the File menu and save project file to the folder below. 

<C:/Yokogawa/FieldWireless/FieldWirelessConfigurator/Project>

Apr. 24, 2013-00
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3.3 Device Provisioning
Device provisioning creates Join Key. The Join Key is a unique key for each Field Wireless De-
vice and needs to be exported to the provisioning file. Exported provisioning file will be imported 
to the Gateway and it allows a Field Wireless Device to join a specific network.

1.  Connect the infrared adapter to Configuration & Monitoring PC. 
•  Make sure that the distance between infrared adapter and infrared communication port on 

the front of the Field Wireless Device is less than 30 cm.

30 cm or le
ss

Infrared adapter

Field wireless device

2.  Start [Provisioning Device Tool] from the Start menu.

3.  Select [Ir Adapter Configuration] from the Tool menu.
Select COM Port that is assigned to “Prolific USB-to-Serial COM Port” for the infrared 
adapter from the pull down menu and click [OK].

Apr. 24, 2013-00
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4.  Select [Get Device Information] and then the information acquisition will start.
Click [OK] when the dialog appears.
• This step requires pointing IR adapter at Field Wireless Device. 

5.  Refer the Table. 1 (Chapter 2) and enter [100] in Network ID and [YTA510_1] in Device Tag, 
and select [Start Provisioning]. 
• This step requires pointing IR adapter at Field Wireless Device.

 

6.  Select “Export Provisioning Data” to save result to a file (example: “YTA510_1_100.ypif”).
• The file includes security key information and it is encrypted.
• Export the provisioning data to the recommended export folder. 
<C:/Yokogawa/Field Wireless/PD>. 

Apr. 24, 2013-00
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3.4 Provisioning File Registration
1.  Select [Devices] tab and click [Open File] icon to import provisioned Field Wireless Device.

Select the provisioning file [YTA510_1_100.ypif] from recommended export folder
<C:/Yokogawa/Field Wireless/PD> and click [Open].
*  Field Wireless Configurator automatically filters out the Field Wireless Devices by Network ID when it imports the Provisioning 

File (.ypif).

2.  Select the device and click [OK].

Apr. 24, 2013-00
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3.5 Download New Configuration
1.  Select [Download] from the Tools menu.

• Need to save project file again to download new setting.

2.  Select [Test connection] to confirm the connectivity between Gateway and Configuration & 
Monitoring PC.
Uncheck the [Devices] from the download list and Select [Start download].
Click [Yes] to start downloading.

NOTE
Field Wireless Device needs to be joined before downloading configuration.
Therefore download all the other configurations before downloading Field Wireless Device con-
figuration.

Apr. 24, 2013-00
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3.  Ensure that there is no error and click [Close]. 

4.  Check the “Devices” from the download list and Select [Start download].
Click [Yes] to start downloading. 

Apr. 24, 2013-00
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5.  Ensure that there is no error and click [Close]. 
•  If you get a following error message, wait for 3 minutes and then click [Start download] 

again.
Error message
“[Device Tag] download failed due to EUI64 read IDENT_NUMBER configured NG due to 
timeout !!”

6.  Select [Close] in the Download Project Data dialog box and click [Exit] from the File menu to 
exit Field Wireless Configurator.

Apr. 24, 2013-00
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4. Confirmation

4.1  Wireless System Confirmation
Confirm the join status, publish status and device role after Field Wireless System configuration.

 Start Field Wireless Management Tool
1.  Start Field Wireless Management Tool from the Start menu of Configuration & Monitoring 

PC.

2.  Enter a new connection name in the Connection drop-down list and enter the IP Address of 
the Gateway to be connected.
The default authentication information is as follows. (Username: “admin”, Password: “!ad-
min”)

Apr. 24, 2013-00
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 Set View Menu
1.  Select [View] from the Main menu and enable the View option [Devices] and [Readings].

• Devices
The Devices tab page features a list of the devices in the network.
It allows you to search devices based on their device tag and EUI-64 address using the 
search function, and execute several device commands.

• Readings
The Readings tab page allows you to view the last readings received from devices, which 
are generated by automatic Publish/Subscribe commands. 

Apr. 24, 2013-00
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 Devices
The Devices tab page shows a list of the joined devices in the network.

1. Click [Devices] from the Tab menu.
2. Ensure that [Device Role] indicate “IO” and [Device Status] indicates “Full Join”

• Click [Search] to refresh the Field Wireless Devices information. 

Apr. 24, 2013-00
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 Readings
The Readings tab page shows the last transferred values from devices.

1. Select [Readings] from the Tab menu or [Readings] icon on the toolbar.
2. Ensure that [Value] and [Status] are below.

•  [Value] : Received value from the Field Wireless Device.
•  [Status]  : Normal operation (PV Status =0x80 and DIAG_STATUS =0x1) 

NOTE
•   It takes approximately 15 to 30[min] to publish the data after Field Wireless Device has joined 

the network.
•   Click [Search] to refresh the Field Wireless Devices information.

4.2  Backup Files Confirmation
Ensure that all files below have been saved to recommended folder after the system configura-
tion.
• Provisioning File
 Extension : ”.ypif”
 Recommended folder :<C:/Yokogawa/FieldWireless/PD> 

• Field Wireless Configurator setting info
 Extension : ”.yep”
 Recommended folder :<C:/Yokogawa/FieldWireless/FieldWirelessConfigurator/Project>.

Apr. 24, 2013-00
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5. Monitoring Network Status
In addition, three view menu options below enable monitoring the network status of ISA100.11a 
Field Wireless Netwrok.
• Network Topology
• Network Health
• Neighbors Health

 Set View Menu
1. Select [View] from the Main menu and enable following View options.

[Network Topology] 

[Network Health] 

[Devices]

 

Apr. 24, 2013-00
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 Network Topology
The Network Topology graphically displays the current network topology information including 
number of hops. 
The topology graph displays the devices on multiple layers delimited by horizontal lines, the lay-
ers being numbered from 0 to n. The layer number indicates a number of hops.

Field Wireless Integrated Gateway YFGW710 has four functions, Gateway(YFGW-GW001), 
System Manager / Security Manager(YFGW-SM001), and Backbone Router(YFGW-BBR001). 
These functions are found on layer 0 and device (YTA510_1) is located on layer 1 in this exam-
ple.

1. Select [Network Topology] from the Tab menu.
2. To view all the links among devices, enable the [Show all links] and [Autorefresh every] op-

tion at the bottom right corner.

NOTE
It takes 15 to 30[min] to display the network topology after Field Wireless Device joined the net-
work.

Apr. 24, 2013-00
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 Network Health
The Network Health provides communication health reports such as number of transmission 
packets, number of lost packets and device join count. The number of lost packets is equal to the 
number of retransmission, which is one of the network quality indicators. 

1. Select [Network Health] from the Tab menu.
2. Confirm the [DPDUs Sent], [DPDUs Lost] and [Join Count] column.

[DPDUs Sent] shows summary information of total number of transmissions and 
[DPDUs Lost] shows the total number of packets which failed to reach destination per de-
vice. 
PER(packet error rate) is calculated by dividing [DPDUs Lost] by [DPDUs Sent].
[Join Count] shows the total number of joins per device.

NOTE
Displayed information will not refresh automatically, Click [Refresh] to update.

Apr. 24, 2013-00
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 Neighbors Health
The Neighbors Health tab page displays communication health reports such as signal strength 
information on the selected device’s neighbors.

1. Select [Devices] from the Tab menu and double click [YTA510_1].
2. Click [Neighbors Health] and confirm the [Signal Strength] column.

[Signal Strength] shows the signal strength (measured in dBm) between selected device 
and neighbors.

NOTE
It takes 15 to 30[min] to display the neighbors Health after Field Wireless Device joined the net-
work.

Apr. 24, 2013-00
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Appendix 1 Modbus Protocol

 Overview
Gateway provides Modbus/TCP server (slave) function. During Modbus communication, the 
Field Wireless Device data is transmitted to the host system. Below are supported Modbus func-
tion codes.
• Read Input Register (3X)
 Modbus Function Code: 0x04, Address: 0 to 66535
• Write Holding Register (4X)
 Modbus Function Code: 0x10, Address: 0 to 66535
Before transmitting data to a host system, it is necessary to map the transmission process value,
device status, alert information and other data on registers.
In the host systems, system engineering is required to embed the error detection mechanism us-
ing Device Status of each wireless system component, Process Data Status, and self-diagnosis 
status (DIAG_STATUS) of the field wireless device; error types can be identified.

NOTE
Process Value will hold previous value if the Communication error or Sensor error occurred.
Therefore you need to check the Process Data Status in order to confirm the data quality.

 Parameters
[PV]
Below is the Process Value data block. Data block always starts with 8bit “Data Status” informa-
tion.

Data Status
(8bit :Unsigned16)

Value
(32bit: Float)

The Modbus registers are all 2 bytes (1 word). Therefore, PV is mapped as below with 8bit re-
served space.

16 8 7 0
00000000 Data Status(8bit)

Value (Upper 16bit) 
Value (Lower 16bit)

Apr. 24, 2013-00
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Below is an example of 8bit Data Status information for PV. Typically host system checks first bit 
(Bit7) to determine data quality. (0x80(128): Good condition without error)

(Example of wireless communication status)
Not Join / Leave : 0x08(8) : Not Connected
Removing Battery : 0x14(20) : No Communication with Last Usable Value.

User specific communication timeout based on “stale limit” setting.
Join Phase : 0x18(24) : No Communication with No Usable Value.

[DIAG_STATUS]
ISA100.11a Field Wireless Device supports self-diagnostics data block which is called DIAG_
STATUS. Below is the DIAG_STATUS data block. Data block starts with 8bit “Data Status” 
information.

Status
(8bit :Unsigned16)

DIAG_STATUS
(32bit: Unsigned32)

DIAG_STATUS is mapped as below with 8bit reserved space.

16 8 7 0
00000000 Status(8bit)

DIAG_STATUS(Upper 16bit)
DIAG_STATUS(Lower 16bit)

Apr. 24, 2013-00
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Below is an example of DIAG_STATUS information. Typically the host system checks the first 4 
bits (Bit28 to Bit31) to determine device diagnostics results. Alarm categories, F, C, O, and M are 
configurable.

Bit0 always indicates “1: available”. 

Apr. 24, 2013-00
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Appendix 2  Configuration Items (Blank 
Form)

 Device Provisioning
Item Settings Remarks Chap

Network ID Numeric identity of a Field Wireless Network.
(2 to 65535)

3.3
Device Tag

A name assigned to the Field Wireless De-
vice for identifying the device.
(Up to 16 single byte alphanumeric char-
acters, A-Z, 0-9, and special characters, 
underscore and hyphen)

 Network setting
Item Settings Remarks Chap

Network Information - -

3.2.1

Network 
Information

Network ID 100 Numeric identity of a Field Wireless Network.
(2 to 65535)

Description Not used in this configuration -
IPv4 Settings - -

IP Address 192.168.0.101 Network parameters necessary to connect 
Gateway and the PC through Ethernet.  
Do not use identical IP addresses on the 
same Ethernet.

Subnet Mask 255.255.255.0

Default Gateway 192.168.0.1

NTP Server IP Address 192.168.0.1
Select the time synchronization method of 
the system. If the server is not used, set the 
same IP address as that of Default Gateway.

Gateway - -

Device Tag Use default setting 
[YFGW-GW001]

-

System Manager / Security Manager - -

Device Tag Use default setting 
[YFGW-SM001]

-

Channels Use default setting [0-14] -

Topology Star
Specify the network topology. 
The following two types can be selected. 
Star (default) , Mesh

Max Nodes Use default setting [50] -
Max Latency (%) Use default setting [0] -
Max Device Timeout (sec) Use default setting [120] -
Advertise Period (sec) Use default setting [7] -
Join Links Period (sec) Use default setting [4] -
Packet Error Rate (%) Use default setting [15] -

Backbone Router - -

Device Tag Use default setting 
[YFGW-BBR001]

-

Filter Bit Mask (hex) Use default setting [FFFF] -
Filter Target ID (Subnet ID) Use default setting [100] -

Field Network 1(PC)

IP Address 192.168.0.102 Network parameters necessary to connect 
Management Station and the Console PC 
through Ethernet. Do not use identical IP ad-
dresses on the same Ethernet.

3.1Subnet 
Mask 255.255.255.0
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	 Field	Wireless	Device	setting
Item Settings Remarks Chap

Device	information - -

3.2.2

Device Tag
A name assigned to the Field Wireless De-
vice for identifying the device.

Device Role
A device role refers to the functional role of 
the field wireless device. Select from (1) IO, 
(2) IO+Router, (3) Router.

Alarms configuration - -

CF /DD CF File 
Name

Confirm the appropriate revision on the  web-
site.(See Table. 5)

Sampling	data - -

Sampling 
Parameters

Update 
Policy

Periodic : Update periodically 
Change of state : Update with change of 
state (Always specify Periodic)

Publica-
tion Period 
(sec)

The setting range is from 0 to 3,600 seconds. 
When “0” is selected, there is no publication.

Stale Limit  
(Times)

When this specified time is exceeded and 
data cannot be received from the field wire-
less device, System Manager considers that 
a communication error has occurred. Com-
munication status bit of Data Status register 
will indicate the error.

	 Modbus	setting

Absolute	Address Input	Register		
Number Allocation Data	Type		

(words)

30001 0

30002~30003 1~2

30004 3

30005~30006 4~5
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